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*************************************** 
Good Food, Good Stories, Good Times 
by Curt B. Witcher 
*************************************** 
The leaf-raking, the frost on windshields more often in the early morning hours, and the talk of 
Thanksgiving plans all are harbingers of end-of-the-year holidays. For many of us, these holidays 
bring good food, good stories, and good times. I want to challenge you to make the last 61 days of 
2011, including the end-of-the-year holidays, truly family history time. To help you do that, I have 
posted a small checklist of things to which you can commit. Don't think about it. Don't worry about 
it. Just do it! 

1. Tell some stories and record some stories this Thanksgiving day. 

2. Take some family pictures and post those pictures this coming Thanksgiving day weekend. Post 
them on Facebook, put them in your virtual photo album, print them and put them in your physical 
photo album, blast an email to your family email list with the photographs as attachments--just 
capture those people and moments, and then share them. 

3. The surgeon general wants us to think and talk about our family health history over the 
Thanksgiving holidays. I challenge you to actually begin recording your family health history if you 
haven't already started, and work to find the cause of death of one more ancestor if you've already 
begun this endeavor. 

4. Together with other members of your family, identify a favorite ancestral recipe, and then 
collectively develop a healthier version of that culinary delight. 

5. This November has a unique Veterans Day: 11-11-11. Do something special by focusing on telling 
richer, more complete stories of your ancestors who served their country. Take copies of the



military documents you have gathered and the scraps of information you have accumulated over the 
years, and actually write a story about one or more of your military veterans. 

6. December 7th will mark the 70th anniversary of the horrible day at Pearl Harbor. Use this 
remembrance to take one of the stories you wrote as your Veterans Day activity and share it on 
WeRelate.org, your Facebook page, your genealogy website, and/or on The Genealogy Center's "Our 
Military Heritage" webpage. 

7. Last week, my colleagues posted a challenge on The Genealogy Center blog--and that was to set a 
genealogical goal of doing something specific and measurable in the month of November. Meet that 
challenge! 

Let the good food, good stories, and good times entice you to do more genealogical good by actively 
engaging. Commit to making "someday" today! 

*************************************** 
Exploring Colonial and Territorial Arkansas Records 
by Delia C. Bourne 
*************************************** 
Explored first by the Spanish, but settled by the French, the area that includes present-day 
Arkansas reverted to Spanish control after the Seven Years War in 1762. In an extremely 
convoluted round of politics, it returned to French hands in 1800, and then was sold to the 
Americans as part of the Louisiana Purchase of 1803. Using the Mississippi River as a trade 
waterway, Americans and other immigrants drifted into the territory starting in the late 
eighteenth century, well before statehood. 

The Genealogy Center holds a number of sources for researching Colonial and Territorial Arkansans, 
starting with M. Carmen Gonzalez Lopez-Briones‛s dissertation “Spain in the Mississippi Valley: 
Spanish Arkansas, 1762-1804” (976.7 G589S), a history of Spain‛s acquisition of and policies for 
the area, and Morris Arnold‛s “Colonial Arkansas, 1686-1804: A Social and Cultural History” (976.7 
AR6AA), which includes a list of judges, 1686-1804, data on sites of colonial settlement and more. 
Arnold also produced “Arkansas Colonials, 1686-1804: A Collection of French and Spanish Records 
Listing Early Europeans in the Arkansas (976.7 AR6A), which includes censuses, petitions, and 
militia lists, as well as maps of Arkansas Post in 1779 and 1832. 

James Logan Morgan compiled “Genealogical Records of Arkansas” (976.7 M82GE, v. 1 & 2) which 
provides obituaries, death and probate notices (including guardian and apprentice notes) from 1804- 
1830, and “Marriages and Divorces of Arkansas” (976.7 M82M) which contains marriage records, 
implied marriages, dower assignments, divorce notices from newspapers, and divorces authorized by 
the Territorial General Assembly. “Early Arkansas residents, 1814-1816” (976.701 AR4CR), by 
Marion Stark Craig, contains tax lists of the counties of Arkansas and Lawrence in the Territory of 
Missouri. Information includes the county and years in which a resident appeared on the lists, as 
well as a notes column that includes name variations. 

One of the most interesting volumes is “A Baptismal Record of the Parishes Along the Arkansas 
River, August 5, 1796 to July 16, 1802” (976.7 B229). With photographic copies of the original



documents on one side and translated transcriptions on the facing page, the records provide the 
child‛s name, parents, godparents, and often identify grandparents. Some of those named also are 
identified by occupation, as in the baptismal record for Elizabeth Berdu, daughter of Alberto 
Bardu, “sergeant of the Louisiana regiment” (27 Oct 1799), or by nationality or race, as in that of 
Thereza Soligny, which notes that both grandmothers were Indian (23 Oct 1799). 

The Genealogy Center also has Henry Putney Beers‛ “French and Spanish Records of Louisiana: A 
Bibliographical Guide to Archive and Manuscript Sources” (976.3 B39F), which offers details of 
records created in the Louisiana Territory, including Alabama, Arkansas, Mississippi, and Missouri, 
with sections on reproductions and archival material, land and church records, followed by a state- 
by-state bibliography of sources. 

If you have ancestors who resided in the Old Southwest before 1830, these sources could assist 
you in locating more information. 

*************************************** 
Ohio Tax Records, 1801-1814 
by Melissa Shimkus 
*************************************** 
Many of our ancestors moved westward through Ohio in the early nineteenth century, and a large 
number of them may have owned land there. Some obtained property through Bounty Land 
Warrants for service in the Revolutionary War, while others purchased land from the federal land 
offices in Ohio Territory beginning in 1800. By the time Ohio obtained statehood in 1803, property 
tax records were already being maintained. “Ohio Tax Records, 1801-1814” is a fifteen-reel set of 
microfilmed property tax lists for selected counties during Ohio‛s early years. 

Available in The Genealogy Center, these microfilms are organized by year, but for each year the 
counties are not always presented in alphabetical order. Within each county, the information is 
arranged either by the first letter of the property owner‛s surname, or by township and then by 
the first letter of the property owner‛s surname. Esther Powell indexed the material in “Early Ohio 
Tax Records” (977.1 P87E), but this index is not complete. 

Details found on the tax lists include not only land values based on specific tax rates, but also land 
descriptions, mentioning waterways, township, range and section, that help locate the physical 
property. For example, in 1801, Thomas Bell paid taxes on property located on the Scioto River in 
Ross County and noted that he had hired a surveyor in 1796 to survey the land, which was in the 
Virginia Military District. If land was transferred between owners, a note was made indicating the 
new owner. In 1806, Abraham J. Williams transferred property situated in Section 12, Township 10, 
Range 21, in Ross County to Huges Woodson‛s heirs, who were not residents of the county. Besides 
revealing who purchased or later obtained the land, the tax lists also may provide a provenance for 
the property. In 1814, Moses Hale paid a tax on land in the Southwest portion of Section 29, 
Township 8, Range 17, in Gallia County that was originally owned by John Graham. With these 
details, a researcher could map out an ancestor‛s property, search deed and probate records, and 
locate other information related to a piece of land or the individuals living on neighboring 
properties.



If you are searching for ancestors in early nineteenth century Ohio, take a look at the “Ohio Tax 
Records, 1801-1814” on microfilm. Benefits include discovering documentation that an ancestor 
owned property in a specific locality, finding a description of the land, and sometimes identifying its 
original or subsequent owner. 

*************************************** 
Technology Tip of the Month--The Microsoft Word Ribbon: Page Layout Tab 
by Kay Spears 
*************************************** 
For those of you who are putting together a book, the Page Layout tab may be the most important 
one in Word. Page Layout is where the Margin setup is located. 

Themes. The first command group on the Page Layout tab enables you to change the way that text, 
tables and special elements are formatted in your document. When you choose a theme, the 
settings are applied to styled elements in your document. There are also Theme Colors, Theme 
Fonts and Theme Effects to choose from in this group. Experiment with the different options and 
remember that positioning your cursor over a selection creates a preview of how the document will 
look. 

Page Setup. The Margins drop down arrow in this group offers preset choices or the option to 
select custom margins. Please remember to leave enough space along the edges of your documents if 
you intend to have them bound into a book. I recommend a margin of at least one inch on all sides. 
Options for establishing page and section breaks in a document can be found under the Breaks drop 
down arrow. The Page Setup dialog box can be accessed by clicking on the arrow in the lower right 
corner of the group. 

Page Background. The Watermark, Page Color and Page Borders tools are all located in this grouping. 

Paragraph. This is the second tab on which you may access the Paragraph command group. It is also 
located on the Home Tab, but this time Indent and Spacing is what you see. However, clicking on 
the drop-down arrow in the lower right corner will take you to the same Paragraph dialog box 
available from the Home Tab. 

Arrange. This group of tools can be used after you have inserted shapes, images, clip art, or 
WordArt into a document. Text Wrap, Bring Forward, and Send Backward also are located here. In 
order for the Bring Forward or Send Backward commands to work, the Text Wrap option for the 
inserted object must be changed from In Line With Text to one of the other options. Rotate and 
Selection Pane options are also available in this group. If you have ever worked with layers in 
Photoshop or another graphics program, you should be familiar with the Selection Pane. While the 
Selection Pane seems to be mimicking the way layers are presented in more advanced software, its 
use here is rather limited. Clicking on an eye on the right side of the Selection and Visibility pane 
will make an image invisible. You can change which object is on top of another by using the Re-order 
arrows at the bottom of the pane. 

Next month:  The Microsoft Word Ribbon: References Tab



*************************************** 
Quick-Tip of the Month for Preservation--Ideas for Organizing Your Materials in Advance of 
Donating Them 
by Dawne Slater-Putt 
*************************************** 
A recent query came to The Genealogy Center about organizing personal archives. The person wrote 
that he has letters, wills, and deeds on a couple of family lines from the turn of the last century up 
until the 1950s.  He wanted to know how to sort and organize those materials as he is "the only 
person now alive to put all the pieces together." He went on to say, "Since you will probably end up 
getting it all, what format and what information do you want?" 

We are grateful the individual thought of The Genealogy Center as a future repository for his 
precious family documents. He was correct in thinking that the more organized the records are, the 
more useful they will be to people using them for family history research in the future. Here are 
some ideas for organization that you might consider. 

1. First, you might strive to get as many of the pieces of paper the same size as possible. For 
example, photocopy smaller certificates, letters and other pieces onto 8 1/2 by 11 pages. These 
days, most copier paper is acid free and will last many generations. If you can do so and retain 
legibility, reduce larger documents down to 8 1/2 by 11 size. Then if you want to keep the original 
certificates and letters, file them in file folders by surname, family branch, location or type of 
document (birth records, death records, correspondence, etc.). 

2. Put the 8 1/2 by 11 sheets in sheet protectors and into 3-ring binders, organized by family, by 
location, or by type of record (whichever makes the most sense to you). If you donate these to The 
Genealogy Center in the future, we will take the pages out of the protectors and 3-ring binders and 
bind them into hardcover books; but until that time, the binders will help you organize the papers 
and find items when you need them. 

3. Be sure when you make the copies that you keep any citation information. It is an excellent idea 
to write the citation information on the fronts of documents, rather than the back, so that if they 
are photocopied, that information is not lost. If you have documents that do not have citations, you 
might try to get that information and write it on the documents while you are organizing. 

4. Consider making a preface, table of contents or some sort of information sheet describing how 
you have organized the documents in your binders, and/or listing them - an inventory of records. 
You can use dividers in the binders to separate families, surnames, generations, or record types. 

This can seem like an overwhelming job, but it is easier if you break it down into small pieces. Tackle 
one file or stack of papers at a time. It is such a worthwhile task to preserve all of this material 
for the future and you are to be commended for being the keeper of the family's history. 

*************************************** 
Military Seminar: You Say You Want a Revolution 
*************************************** 
This year's military seminar highlights Revolutionary War service. This all-day event, featuring



methodology lectures, historical presentations, opportunities for advice on lineage applications, and 
a tour of The Genealogy Center, will be presented by the Mary Penrose Wayne Chapter of the 
Daughters of the American Revolution, the Anthony Halberstadt Chapter National Society Sons of 
the American Revolution, and The Genealogy Center staff on November 12, 2011. 

Morning sessions include instruction on the resources of the National Society Daughters of the 
American Revolution, including how to use the DAR's genealogical records collection and the DAR 
library catalog. Tutorials on the application process for the DAR and SAR will be provided, as well 
as an examination of Revolutionary War pensions. In the afternoon, choose between attending an 
SAR meeting, featuring a program by William Sharp on "The Siege at Bryan's Station," or attending 
a DAR meeting, featuring a presentation by Bob Jones who is a Revolutionary Soldier Re-Enactor. 
You can take a tour of The Genealogy Center and schedule a 30 minute consultation with a DAR or 
SAR member to discuss your specific application to the organization. (Note: You must bring your 
lineage paperwork to the appointment. Due to limited availability, send an email to 
Genealogy@ACPL.Info to schedule your consultation time.) For more information, see the flyer at 
<http://www.genealogycenter.org/Libraries/Brochures/Military_Seminar_2011.sflb.ashx> 
Registration is required for this free seminar. Please call 260-421-1225 or email 
Genealogy@ACPL.Info to register. 

*************************************** 
WinterTech is Here! 
*************************************** 
With the chill in the air, it may not be the time for genealogists to browse cemeteries or take long 
genealogy research trips. However, it is the perfect time to sharpen our technology skills. Held in 
the afternoons on the second Wednesdays, November through February, to coincide with the Allen 
County Genealogical Society of Indiana's monthly evening meetings, WinterTech gives you 
meaningful indoor educational opportunities. This year's WinterTech kicks off with a "WeRelate 
Overview," on November 9, 2011, at 2:30 PM, in Meeting Room C. Cynthia Theusch will explain how 
the WeRelate.org wiki can allow you to post pages about your ancestors, add data to existing pages, 
and share information with other researchers. Future WinterTech Sessions will include information 
on locating books online, a virtual tour of The Genealogy Center's Catalog, and a survey of the 
Origins.net website for British, Irish, and Scots research. For more information, see the flyer at 
http://www.genealogycenter.org/Libraries/Brochures/WT2011.sflb.ashx. Please call 260-421-1225 
or email Genealogy@ACPL.Info to register. 

*************************************** 
Out and About 
*************************************** 
Curt Witcher 
November 5, 2011--Exton, PA--Pennsylvania Family History Day, Wyndham Garden, 815 N. Pottstown 
Pike. Topics presented will be “The Changing Face of Genealogy” and “Mining the Motherlode: Using 
Periodical Literature for Genealogical Research.” 

November 12, 2011--Phoenix, AZ--Arizona Genealogical Advisory Board Annual Workshop, Carnegie 
Center, 1101 W. Washington Street. Topics presented will be “Roll Call: New Sites and Sources for 
Military Records and Research,” “Using Government Documents for Genealogical Research,” “Pain in



the Access: Getting More from the Internet for Your Genealogy,” and “S.O.S.: Saving Our 
Societies--Answering Our Distress Beacons.” 

Melissa Shimkus 
November 19, 2011--Indianapolis, IN--Genealogical Society of Marion County‛s 16th Annual Central 
Indiana Genealogy Conference, Indiana History Center, 450 West Ohio Street. Topics presented 
will be “Before Crossing the Ocean: Records of Our Immigrant Ancestors,” “Visit American Records 
of our Immigrant Ancestors,” “Ellis Island, Online Immigration Records,” and “Naturalization 
Records.” 

***The Genealogy Center in the Indiana Library Federation's Genealogy Pre-Conference*** 
Monday, November 14, 2011, Grand Wayne Center, Fort Wayne, IN 
8:30 a.m. - 10:20 a.m. 
After ‘Who Do You Think You Are?‛--Engaging Beginning Genealogists 
The prime-time NBC hit “Who Do You Think You Are?” has brought many more individuals who have 
never done any genealogical research into our libraries seeking information about their ancestors. 
This workshop will focus on providing a positive first experience and continuing to create engaging 
experiences for novice genealogists. Material covered will include good reference interview 
techniques, how to move the customer from storytelling to data provision, and how to foster 
independent use of our genealogy and local history collections. 
Presenter: Curt B. Witcher 

10:30 a.m. - 12:20 p.m. 
Genealogy‛s Mega Databases: FamilySearch and Ancestry.com 
FamilySearch.org offers an amazing collection of online resources and is available to anyone or any 
institution at no cost. While Ancestry.com requires a subscription fee, its more than 6 billion 
historical records greatly expand any library‛s collection of genealogical resources. This workshop 
will cover FamilySearch online databases, the FamilySearch research wiki, Ancestry search 
techniques and Ancestry collections to show how FamilySearch and Ancestry can exponentially 
expand the resources your library has to offer family historians. 
Presenters: Melissa Shimkus and Dawne Slater-Putt 

1:30 p.m. - 3:20 p.m. 
Net Treats--Useful Free Sites for Genealogists 
This workshop will explore a number of terrific Internet sites for genealogists, all free. Not only 
will the sites be identified but also strategies for successfully using them will be articulated. 
Presenter: Delia Bourne 

*************************************** 
Area Calendar of Events 
*************************************** 
Allen County Genealogical Society of Indiana (ACGSI) 
November 9, 2011--Allen County Public Library, 900 Library Plaza, Fort Wayne, Indiana. 6:30 p.m. 
refreshments and social time, 7 p.m. program. Mark Davis will present: “Hallowed Stones: Cemetery 
Preservation.”



Allen County-Fort Wayne Historical Society, 302 East Berry, Ft. Wayne, IN 
The George R. Mather Sunday Lecture Series, November 6, 2011, 2 p.m. Barbara Morrow will be 
speaking on, “Ahead of Her Time: Gene Stratton-Porter.” 

*************************************** 
Driving Directions to the Library 
*************************************** 
Wondering how to get to the library?  Our location is 900 Library Plaza, Fort Wayne, Indiana, in the 
block bordered on the south by Washington Boulevard, the west by Ewing Street, the north by 
Wayne Street, and the east by the Library Plaza, formerly Webster Street.  We would enjoy having 
you visit the Genealogy Center. 

To get directions from your exact location to 900 Library Plaza, Fort Wayne, Indiana, visit this link 
at MapQuest: 
http://www.mapquest.com/maps/map.adp?formtype=address&addtohistory=&address=900%20Web 
ster%20St&city=Fort%20Wayne&state=IN&zipcode=46802%2d3602&country=US&geodiff=1 

>From the South 
Exit Interstate 69 at exit 102.  Drive east on Jefferson Boulevard into downtown. Turn left on 
Ewing Street. The Library is one block north, at Ewing Street and Washington Boulevard. 

Using US 27: 
US 27 turns into Lafayette Street. Drive north into downtown. Turn left at Washington Boulevard 
and go five blocks. The Library will be on the right. 

>From the North 
Exit Interstate 69 at exit 112.  Drive south on Coldwater Road, which merges into Clinton Street. 
Continue south on Clinton to Washington Boulevard. Turn right on Washington and go three blocks. 
The Library will be on the right. 

>From the West 
Using US 30: 
Drive into town on US 30.  US 30 turns into Goshen Ave. which dead-ends at West State Blvd. 
Make an angled left turn onto West State Blvd.  Turn right on Wells Street.  Go south on Wells to 
Wayne Street.  Turn left on Wayne Street.  The Library will be in the second block on the right. 

Using US 24: 
After crossing under Interstate 69, follow the same directions as from the South. 

>From the East 
Follow US 30/then 930 into and through New Haven, under an overpass into downtown Fort Wayne. 
You will be on Washington Blvd. when you get into downtown. Library Plaza will be on the right. 

*************************************** 
Parking at the Library 
***************************************



At the Library, underground parking can be accessed from Wayne Street. Other library parking 
lots are at Washington and Webster, and Wayne and Webster. Hourly parking is $1 per hour with a 
$7 maximum. ACPL library card holders may use their cards to validate the parking ticket at the 
west end of the Great Hall of the Library. Out of county residents may purchase a subscription 
card with proof of identification and residence. The current fee for an Individual Subscription Card 
is $70. 

Public lots are located at the corner of Ewing and Wayne Streets ($1 each for the first two half- 
hours, $1 per hour after, with a $4 per day maximum) and the corner of Jefferson Boulevard and 
Harrison Street ($3 per day). 

Street (metered) parking on Ewing and Wayne Streets. On the street you plug the meters 8am – 
5pm, weekdays only.  It is free to park on the street after 5pm and on the weekends. 

Visitor center/Grand Wayne Center garage at Washington and Clinton Streets. This is the Hilton 
Hotel parking lot that also serves as a day parking garage.  For hourly parking, 7am – 11 pm, charges 
are .50 for the first 45 minutes, then $1.00 per hour.  There is a flat $2.00 fee between 5pm and 
11pm. 

*************************************** 
Genealogy Center Queries 
*************************************** 
The Genealogy Center hopes you find this newsletter interesting.  Thank you for subscribing.  We 
cannot, however, answer personal research emails written to the e-zine address.  The department 
houses a Research Center that makes photocopies and conducts research for a fee. 

If you have a general question about our collection, or are interested in the Research Center, please 
telephone the library and speak to a librarian who will be glad to answer your general questions or 
send you a research center form.  Our telephone number is 260-421-1225.  If you‛d like to email a 
general information question about the department, please email: Genealogy@ACPL.Info. 

*************************************** 
Publishing Note: 
*************************************** 
This electronic newsletter is published by the Allen County Public Library's Genealogy Center, and 
is intended to enlighten readers about genealogical research methods as well as inform them about 
the vast resources of the Allen County Public Library.  We welcome the wide distribution of this 
newsletter and encourage readers to forward it to their friends and societies.  All precautions have 
been made to avoid errors.  However, the publisher does not assume any liability to any party for 
any loss or damage caused by errors or omissions, no matter the cause. 

To subscribe to “Genealogy Gems,” simply use your browser to go to the website: 
www.GenealogyCenter.org. Scroll to the bottom, click on E-zine, and fill out the form. You will be 
notified with a confirmation email. 

If you do not want to receive this e-zine, please follow the link at the very bottom of the issue of



Genealogy Gems you just received or send an email to kspears@acpl.lib.in.us with "unsubscribe e- 
zine" in the subject line. 

Steve Myers & Curt Witcher, co-editors


